Email Management

Five Quick Tips




Webinar Companion Handout

Why Care about Email Management?

A recent study showed that, on average, office workers receive over 300
emails in a week!. Some workers receive that many emails or even more
in a single day. Many suffer from email overload.

To deal with the influx of messages, the same study showed that 80% of
workers always keep their email open. Others resort to checking it at a rate
of 36 times an hour!

And it’s not just reading emails, writing emails can be a large part of office
work. One article reports that “the average employee spends 10 hours

and 47 minutes a week drafting emails.” ?
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We can maximize our ability to manage our email by leveraging a combination of technology and behavior

change.

Although we will focus primarily on technological solutions, we can use common time management strategies

when managing email.

Do Defer/Schedule

* Urgent * Not Urgent
* Important * Important

Pomodoro Technique:

Strategies to consider include the Eisenhower Matrix (see picture),
Pomodoro Technique, and the 1-3-5 rule.

e Set your timer for 25 minutes and focus on a single task.
e Enjoy a five-minute break and repeat timer session.

" Delegate Delete e  After four sessions, take a longer break.

* Urgent * Not Urgent
* Not Important * Not Important 1'3'5 RUIe:

To maximize your productivity, each day focus on:

J e 1 large task, 3 medium tasks, and 5 small tasks
Eisenhower Matrix
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Technology provides us with tools to implement these strategies.

Tip #1: Use Search Folders

If you find yourself frequently performing the same searches in Outlook, you can create

permanent searches by using Search Folders.
Here’s how:
To create a New Search Folder...
1. Right click on Search Folders

2. Inthe New Search Folder dialog box that appears, select the type
of Search Folder you would like to create.

There are 13 preconfigured search options in the following
categories:

e Reading Mail,
e Mail from People and Lists, and
e Organizing Mail

3. Click OK.

> Conversation History
Search Folders
L @ New Search Folder...
RS

New Search Folder

Select a Search Folder:

Reading Mail a
Unread mail
Mail flagged for follow up
Mail either unread or flagged for follow up
Important mail

Mail from People and Lists
Mail from and to specific peaple
Mail from specific people
Mail sent directly to me
Mail sent to public groups

Organizing Mail

Fatanarizad mail

Customize Search Folder:

To specify aiteria, dlick Choose.

oK. Cancel

Combine the functionality of Categories with Search Folders to easily find emails that you’ve already filed no

matter where they are stored.

Depending on your account type, you may be able to use Search Folders with Classic Outlook, Outlook on the
Web, and New Outlook. You can achieve similar results by using filters and labels in Gmail.

Q, Search in mail @

Doesn't have

Size greater than - MB
Date within 1day -
Search All Mail

[0 Hasattachment [J Don'tinclude chats

You can add multiple categories (or labels when you are in Gmail) to messages. Extend this tip by using Rules (or
filters in Gmail) to automatically categorize messages as they come into your inbox.
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Here are some links to get you started:

e Create labels to organize Gmail - Computer - Gmail Help (google.com)

e Using Gmail labels, colors & filters to sort important emails (wisestamp.com)
e Manage email messages by using rules

%
@

Tip #2: Use Quick Steps

. .' Quick Steps allow you to automate common tasks. By default, you can quickly move,
=

« forward, reply, and delete messages as well as clear flags.

To create a Quick step O T
1. On the Home tab, select New Quick Steps E Y T.IWTM.....,...HHW

from the Quick Steps group. = e T T ————
2. Select an action from the list of options. R :33 R
3. Inthe Edit Quick Step dialog box, configure -

the action.
4. Click Finish.
You can create custom Quick Steps by using New (] Cuptcate | Doty

dropdown and selecting Custom.

o L=

A total of 24 options falls under the headings
Filing, Change Status, Categories, Respond,
Appointment, and Conversations.

Tip #3: Use Quick Parts

Outlook and Word allow you to save and reuse frequently used language using Quick Parts.

Once you save text as a Quick Part, just add it to your message when you need it. Some already do this by using
signatures. However, one advantage of using Quick Parts is that you can organize your text snippets and create
keywords to automatically populate them to your messages.

To create a new Quick Part:

Select existing text in your document or email.

In the Text group on the Insert tab, select Quick Parts.
Click Save Selection to Quick Part Gallery...

Complete the fields in the Create New Building Block
dialog box.

5. Click OK.

PwnNe
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https://support.google.com/mail/answer/118708?hl=en&co=GENIE.Platform=Desktop
https://www.wisestamp.com/blog/using-gmail-labels-to-sort-important-emails/
https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-c24f5dea-9465-4df4-ad17-a50704d66c59

To insert an existing Quick Part:

1. Select an area in the body of your email.

2. Go the Insert tab, go to the Text group and select Quick Parts.
You will see a Gallery containing previews of all the text that you've saved.
3. Select an existing Quick Part.

You can mix and match saved text snippets to meet your needs. Although you can add text to Quick Steps, you

can combine them with Quick Parts when you need to preserve formatting.

In Outlook on the Web and Gmail, you can access similar functionality by using Templates.

Outlook on the Web/New Outlook

- ul]ﬂ 4
| et

My Temy

View and Manage Templates

* I'mrunning late

These links provide tutorials on how to create templates:

o| | Wnen you appiy styles, your headings change to

E} My Templates X

I'll reply later

Heading to a meeting. 1l get back to you soan.

Im running latz

Lunch?

1 fior lunch this aftemaan?

Do you want

OWA Example 2

match the

w

Gmail

New Message -2 x
Recipients

Subject

Take a look at how easy it i to insert it into my email.

Video provides a powerful way to help you prove your point. When you click Online Video,
You can paste in the embed code for the video you want to add. You can also type a

keyword to search online for the video that best fits your document.

To make your document look professionally produced, Word provides header, footer, cover
page, and text box designs that complement each other. For example, you can add a
matching cover page, header, and sidebar, Click Insert and then choose the elements you
want from the different galleries.

Default to full screen

Themes and styles also help keep vour document !

chooseanew Tt \yseorrempLaTE Templates
new theme.
Template2 Label
When you app\1 Gmailysion | Plain text mode
SavetimeinWo [] Save draft as template , Print
way a picture i Check spelling
it.Whenyouwe [ pelete template »
the plus sign.

{9 Setup atime to meet

mAC-DcD@f:?'a'

e How to create an email template in new Outlook and web app

e How to create and use Gmail templates to streamline your workflow

S

)

© Rainwater Growth LLC

Email Management


https://www.ablebits.com/office-addins-blog/email-templates-new-outlook-web/
https://www.businessinsider.com/guides/tech/gmail-templates?op=1

Tip #4: BLUF Your Subject

By creating clear, meaningful subject lines, you help your recipients help you. For your
business emails, it is important to always include a subject line.

By adding a keyword to your subject such as ACTION, FYI, or QUESTION, you assist your readers and help them
know how to prioritize your messages.

Here are some other keywords that you may want to use:

FYNA (For Your Necessary Action) FYI INFORMATIONAL
FEEDBACK REQUESTED INFO ASSISTANCE REQUEST

For emails that require an action, you can extend this tip by including the timeframe.

N O @ |From To Subject Received ¥ Size Due Date|Rece...| ¥ o

Microsoft Outlook ... RWG Demo Acc... Welcome to your new Outlook.com account and ... Thu 1/4/20243:03AM 63 KB None
Hello RWG Demo Account, Your agenda for Thursday, January 4, 2024 All day

6_) Microsoft Qutlook ... RWG Demao Acc... Welcome to your new Outlook.com account and ... Thu 1/4/2024 3:03 AM 61 KB None
Hello RWG Demo Account, Your agenda for Thursday, January 4, 2024 Al day

Microsoft Outlook ... RWG Demo Ac... Daily Standup and 2 other events today Wed 1/3/2024 3:01 AM 60 KB None
Hello RWG Demo Account, Your agenda for Wednesday, January 3, 2024

€5 Microsoft Outlook ... RWG Deme Acc... Daily Standup and 2 other events today Wed 1/3/20243:01 AM  61KB None
Hello RWG Demo Account, Your agenda for Wednesday, January 3, 2024

Microsoft Qutlook ... RWG Demo Acc... Welcome to your new Outlook.com account and ... Tue 1/2/2024 3:01 AM 68 KB Hone
Hello RWG Demo Account, Your agenda for Tuesday, January 2, 2024 All day

Microsoft Outlook ... RWG Demo Acc,.. WElcame to your new Outlook com account and 4 other events today g 68 KB Thu 1/1... Ft' ]E
Hello RWG Demo Account, Your agenaJ}:rTuesaay January 2, 2024 All day

| Microsoft Outlook ... RWG Demo Ac...] ACTION Due by 01/18/24: Confirm Your Account... Mon 1/1/2024 3:00 AM 79 KB None

Hello RWG Demo Account, Keep track ofyour dally events and fasks with Outlook agenda mail. First things first Confirm your account

Microsoft Outiook ... RWG Demo Ac... New Year's Day and 5 other events today Mon 1/1/2024 3:00 AM  76KE  None
Hello RWG Demo Account, Keep track of your daily events and tasks with Outlook agenda mail. First things first Confirm your account

v Last Month
{0 outiook Team RWG Deme Acc... Vague email that needs action Fri 12/1/2023 %:47 PM 729K None

Hi RWG Demo, Welcome to your Outlook! We're the email service designed to help you conquer your day. Connect, organize, and get

Qutlook Team RWG Demo Acc... Welcome to your new Outlook.com account Fri 12/1/2023 9:47 PM 719KB Hone
Hi RWG Demo, Welcome to your QOutlook! We're the email service designed to help you conguer your day. Conned, organize, and get

4

You may see better results if you include your keyword at the front of your subject line because your recipient
may view your email on a mobile device or may not see your entire subject for another reason. Of course, you
want to stay within your company guidelines.

By using keywords as prefixes, you put the Bottom Line Up Front or BLUF your subject lines.

Once you have identified the keywords that appear most often in your emails, you can use this information to
build rules, search folders, and automation to quickly find, file, and categorize messages.
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Tip #5: Automate! 59

Even if you have already automated many of your email actions using a combination of
Outlook features such as Rules, Quick Steps, and Quick Parts, you can take your automation to O
another level by using a tool like Power Automate.

If you’ve ever used If This, Then That (IFTTT), Power Automate is

Apps similar tool from Microsoft to create automation using many business
E Qutlook ‘ QOneDrive app“cations'
[ cipchamp ¥ Designer Power Automate flows are ways to create highly customized rules to
help you automate many tasks, not just emails.
ﬂ Werd a Excel ’
@ roverroine LI cnetote If you are using Outlook on the Web, you can easily get to Power
Automate by clicking the 86 Waffle menu and selecting Power
G rorm: B coenoar Automate. You may have to select All apps-> to see the Power
& 700 i Team Automate menu item.
O soee If you use Classic Outlook, you can type
https://make.powerautomate.com into your browser to get to the

Power Automate home page.

On the Power Automate home page, Microsoft offers tutorials to help you get started. The home page also
includes links to the latest updates.

[or—
£ Defaut Environment

i Power Automate

t  Create e

Hello, Rainwater

Create a flow to automate a repetitive business task end to end.

M team v

- . -+ Create
o Myflows i & =

[o Approvals & v a

D Process mining

O Ahub o
® Learning for every level ses

@ @ process with Microsoft @ aatomaton wo @ Robotic Process.. @
Beginner 45 min inner 43 min Beginner hr Intermediate 'S min

¢ Power Platform o)

® 00O

More to explore in Power Automate

Pricing Video how-tos Community forum Docume

Power Automate plans and add-ons or Watch and leam with dozens of helpful YouTube Connect with peers, share ideas, and leam from Leam or

videos. the experts. dev.

You can search through existing templates and customize one that best meets your needs. You can build Power
Automate flows to automate many email tasks, including those tied to Google Workspace accounts (if permitted
by your organization.)
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https://make.powerautomate.com/

Rainwater Growth, LLC

Rainwater Growth is your source for quality, affordable training, and research. Our mission is to provide free
and low-cost training for individuals, small businesses, and non-profits.

Check out our website to read our blog to learn and explore sources of free and low-cost training, to invest in
custom training, or to get a quote for technology research.

Website: https://www.rainwatergrowth.com

You can also join one of our Meetup groups to learn about upcoming free training courses from a variety of
vendors.

e DMV Tech Upskilling
e Upskilling in the ATL

On our Eventbrite page, you can find out about our upcoming interactive live training classes.

https://rainwatergrowth.eventbrite.com

Finally, you can follow us on Flipboard or LinkedIn to catch-up on the latest tech news and tutorials.

e Flipboard: https://flipboard.com/@RainwaterGrowth
e LinkedIn: https://www.linkedin.com/company/rainwater-growth-training-and-consulting/

e

DunwateR GoOWTH
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